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In this section:

Adding 
Graphics to Your 
Documents

The images you add to your documents—whether you’re cre-
ating a business report, a newsletter for your garden club, 

invitations for your son’s graduation party, or a flyer for a new 
product—invite people in for a closer look. Images bring color, 
energy, and life to the words on the page. Whether you’re show-
ing pictures of happy people, capturing a beautiful landscape, 
spotlighting a product, or creating a piece of abstract art, the 
images in your document can inspire and uplift people, while 
encouraging them to stick around and read what you’ve written.

Microsoft Word 2010 includes a number of picture tools that 
help you fine-tune your pictures and add professional, artistic 
touches that can really make your work stand out. New features 
in Word 2010 enable you to add artistic effects—including all kinds 
of special filters—to the images you add. And the enhanced 
cropping tool makes it simple for you to display just the aspect 
of your image that is sure to get the most attention.

6
■■ A Quick Look at Word 2010 

Illustrations

■■ Inserting a Picture

■■ Changing the Size of a Picture

■■ Adding Clip Art and Shapes

■■ Editing and Formatting a Picture

■■ Getting Artistic with Pictures

■■ Removing Picture Backgrounds

■■ Wrapping Text Around a Graphic 

■■ Arranging Multiple Graphics

■■ Positioning Graphics on the Page

■■ Creating Artistic Text

■■ Inserting a Relational Diagram

■■ Creating a Chart



A Quick Look at Word 2010 Illustrations
Years ago, adding a photo or a diagram to a document was 
a pretty big deal. Today it’s very easy to do and what’s more, 
you can apply all sorts of professional effects to make the 
images look great on the page. In the Illustrations group of 
the Insert tab, Word 2010 gives you the tools to add several 
different types of illustrations to your document so that you 
can inspire your readers with photographs, drawings, charts, 
diagrams, screenshots, and more.

Pictures
Chances are that you’ll use the Picture tool quite a bit. Using 
this tool, you can add photos or other artwork you’ve already 
saved in folders on your computer. Once you put the picture 
in place, you can use Word’s picture editing tools to fine-tune 
its appearance.

Clip Art
Word 2010 offers a large collection of clip art—with more 
being posted all the time—and connects directly to Office.com 
so you can always access the great number of downloadable 
art available for free online. And clip art isn’t just cartoons—
you’ll also find photos and sound and video clips available 
through the Clip Art tool.

Shapes
If you want to create your own illustrations in your document, 
Word 2010 offers a large collection of ready-made shapes 
you can add directly to your page. You can create a drawing 
canvas and add the custom illustration there or simply click 
the shape you want and draw right on the page.
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SmartArt
SmartArt graphics give you a simple way to create professional-
looking diagrams, helping you illustrate key ideas in the 
documents you create. SmartArt offers a number of different 
diagram styles, and you can customize all the diagrams you 
create within each style type.

Charts
You can create and insert a variety of chart types directly 
into your Word documents using the Chart tool in the Illus-
trations group. A datasheet enables you to add and modify 
chart values; you can customize the chart to add titles, labels, 
values, formatting, and more.

Screenshots
A new feature in Word 2010 enables you to capture and insert 
screenshots in your Word documents. You might do this, for 
example, when you want to show a picture of your business 
Web site or when you are illustrating a book like this one. 

Adding Graphics to Your Documents
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Inserting a Picture
Adding pictures to your document livens things up and gives 
your readers something colorful to capture their interest. If 
you’re creating a dry report, you can include a photo of key 
staff members to personalize the document. If you’re writing 
Web copy, you can add images of your building, the surround-
ing landscape, your products, or happy customers to paint a 

positive image of what you do. Inserting a picture is a simple 
task in Word, and Word accepts images in a number of different 
file formats, as you can see in the following table. This means 
you can use pictures from a wide variety of sources—nothing 
goes to waste!

Picture Format Name File Format

Windows Enhanced Metafile .emf

Windows Metafile .wmf

JPEG File Interchange Format .jpg, .jpeg, .jfif, .jpe

Portable Network Graphics .png

Windows Bitmap .bmp, .dib, .rle

Graphics Interchange Format .gif, .gfa

Compressed Windows Enhanced Metafile .emz

Compressed Windows Metafile .wmz

Compressed Macintosh PICT .pcz

Tag Image File Format .tif, .tiff

WordPerfect Graphics .wpg

Computer Graphics Metafile .cgm

Encapsulated PostScript .eps

Macintosh PICT .pct, .pict

“Adding Clip Art” on page 134 for information 
about inserting pictures that you’ve cataloged 
using the Clip Organizer. 

See Also

Most of us today have lots of digital pictures, 
and Office 2010 comes with a valuable tool 
that can help you manage your media effec-
tively. The Microsoft Office Picture Manager 
is available in Microsoft Office Tools. Simply 
click Start, click All Programs, click Microsoft 
Office, and choose Microsoft Office Tools. Click 
Microsoft Office Picture Manager to open the 
software and begin working with your photos.

Try This!
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Insert a Picture

1	 Click in your document where you 
want to insert the picture.

2	 On the Insert tab, click the Picture 
button in the Illustrations group to 
display the Insert Picture window.

3	 Navigate to the folder that contains 
the picture you want and click the 
picture file.

4	 Click the down arrow next to the 
Insert button and click one of the 
following:

•	 Insert to copy the picture and store 
it in the Word document.

•	 Link To File to connect to the pic-
ture file without increasing the file 
size of your Word document. (The 
source picture file must be available 
for the picture to be displayed.) 

•	 Insert And Link to copy the picture, 
store it in the Word document, and 
update the picture automatically 
whenever the source picture file 
changes.

1

3 4

2

“Editing and Formatting a Picture” on page 137 for information 
about modifying a picture or its placement. 

See Also
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Cropping handle

Changing the Size of a Picture
Pictures come in all shapes and sizes, and depending on how 
you have your digital camera options set (or where you found 
your images), your pictures might be extremely large. When you 
insert them on your page, they may overwhelm your text. 

There are two different ways you can get your pictures down to 
a manageable size—you can resize the entire image or you can 
crop the image to just the part you want. Or, of course, both.

Crop It

1	 Click the picture and click the Picture 
Tools Format tab.

2	 Click Crop in the Size group.

3	 Place the cropping mouse cursor over 
a cropping handle and drag the sides, 
top, or bottom of the picture to crop 
off the parts you don’t want. 

4	 Click outside the image to turn off 
cropping.

When you drag a Sizing handle, your picture 
can become distorted. To change its size but 
keep its original aspect, adjust the picture’s 
size in the Size section of the ribbon.

Tip
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3

Sizing handle

Size It

1	 Click to select the picture if it isn’t 
already selected.

2	 Drag a Sizing handle on the picture 
to modify the size of the picture.

3	 Click outside the image to complete 
the process.

Now in Word 2010 you can crop a photo to a shape to add 
special touches to your files. Add a photo to your page by 
clicking Insert, Picture, and choosing the photo you want to 
add. Click Insert to paste the photo at the cursor position. 
Now click the photo and click the Picture Tools Format tab. 
In the Size group, click the Crop arrow, and point to Crop To 
Shape. Click the shape you want to apply to the photo and 
watch what happens on your page! The photo is cropped to 
the shape you selected. You won’t want to use this often in 
your publications and worksheets, but once in a while it’s a fun 
feature.

Try This!

If you want to crop your photo to a specific shape, you can set 
the aspect ratio before you crop. To do this, click the Picture 
Tools Format tab and click the Crop arrow in the Size group. 
Point to Aspect Ratio and click the ratio you want to apply to 
the image.

Tip
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Adding Clip Art
Word 2010 gives you access to clip art, photographs, video, 
and audio clips that are included with the program as well as 
a whole world full of clips available online at Office.com. When 
you search for a specific illustration you’d like to use for your 
document, you can enter a simple word or phrase—computer, for 

example—and the Clip Art tool will provide you with dozens of 
results to review. When you add a picture to a document, the 
picture becomes part of the document, and you can edit and 
change it as you’d like.

Find and Insert Clip Art

1	 Click in your document where you 
want to place the clip art.

2	 On the Insert tab, click Clip Art in the 
Illustrations group. 

3	 In the Clip Art pane, type a keyword 
or keywords to describe the type of 
picture you want.

4	 Specify the type of clip you want.

5	 Click to include clips from Office.com 
in the search.

6	 Click Go to view the items that match 
your criteria.

7	 Click to insert the picture into your 
document. Add any other clip art 
you want, and close the Clip Art pane 
when you’ve finished.

“Changing the Size of a Picture” on page 132 for information 
about cropping and resizing the clip art.

See Also

“Editing and Formatting a Picture” on page 137 for information 
about modifying the clip art.

See Also
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Adding Shapes
For some documents you may want to draw things yourself. 
Word 2010 includes a palette of shapes you can use to create 
all sorts of images—buttons, boxes, and much more—on your 
page. You can use shapes as containers for text and create pull 

quotes, sidebars, coupons—almost anything you can envision 
you can create. Once you’ve drawn the shape, you can add 3-D 
effects, shadows, or special formatting touches to make the 
shape stand out.

Draw a Shape

1	 Click in your document where you 
want to insert the shape. 

2	 On the Insert tab, click Shapes in the 
Illustrations group, and choose the 
shape you want from the gallery that 
appears.

3	 Hold down the left mouse button, 
and drag out the shape.

(continued on next page)
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Sizing
handle

Rotation
handle

4	 Adjust the shape by dragging the 

•	 Sizing handles to change the size of 
the drawing.

•	 Adjustment handle to reshape the 
drawing.

•	 Rotation handle to rotate the 
drawing.

5	 Change the shape fill and outline 
color.

6	 Use Shape Effects to apply special 
effects—including shadow, glow, and 
more—to the shape. 

“Adding Shapes” on page 135 for 
information about modifying the 
appearance of a shape.

See Also

“Arranging Multiple Graphics” 
on page 144 for information 
about combining multiple 
shapes for special effects.

See Also

“Creating Artistic Text” on page 148 and 
“Adding Text Boxes” on pages 87–89 for infor-
mation about customizing the text and text 
layout in a text box.

See Also

Draw a Shape (continued)
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Editing and Formatting a Picture
Word 2010 includes some great picture editing tools that 
enable you to fine-tune your images, adjusting brightness, 
contrast, and color. In addition to picture editing tools, you can 
apply special artistic effects to give your pictures a professional 

appearance, displaying them, for example, as watercolor prints, 
ink drawings, or even images through glass. Using these types 
of special picture enhancements help you create a document 
your readers will remember.

Change Its Appearance

1	 Click the picture and click the Picture 
Tools Format tab.

2	 Click Corrections.

3	 Click the setting you want to apply to 
the image.

When you edit a picture, you’re editing only the 
copy of it that you’ve inserted into your Word 
document. If you want to change the original 
picture file, you’ll need to edit it in a separate 
program—for example, in Windows Paint or 
Microsoft Office Picture Manager.

Tip

Editing and Formatting a Picture  137

Adding Graphics to Your Documents



2 4 5

3

1

Format
shape

Format a Picture

1	 Click the picture you want to format.

2	 Click the Picture Tools Format tab.

3	 Click the More button in the lower-
right corner of the Picture Styles gal-
lery to display all your choices, and 
click the style you want to apply.

4	 Click Picture Border to choose a new 
color for the border or change border 
style.

5	 Click Picture Effects to add or change 
the 3-D rotation, shadow, reflection, 
glow, or soft edges.

If you want to set precise values for brightness, contrast, shad-
ows, or 3-D settings, including rotation, click the Format Shape 
button. To rotate a picture 90 or 180 degrees, click the Rotate 
button in the Arrange section of the ribbon.

Tip
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Getting Artistic with Pictures
You’ve probably noticed that documents get better looking all 
the time. Changes in technology have made it possible for us 
to take lots of pictures and include those pictures in the work 
we produce. Word 2010 includes a great new feature called 
Artistic Effects that makes it simple for you to create unique 
and professional effects for your pictures. You can apply all 

sorts of different filters to create different looks and give new 
life—and lots of visual appeal—to the pictures you include on 
your pages. You can also recolor the pictures you use to create 
special picture effects that correspond to other colors used in 
your document.

Apply Artistic Effects

1	 Click the picture in your document.

2	 Click the Picture Tools Format tab.

3	 Click Artistic Effects and hover the 
mouse over the different effects.

4	 Click the effect you want to apply.

If you don’t like the result of the effect 
you’ve applied, click Reset Picture to 
reset the entire picture to the way it 
looked when you first inserted it.

TipThe Reset Picture button resets all 
the changes you’ve made, including 
any cropping or sizing. If you want to 
undo only one or two changes, use 
the Undo button on the Quick Access 
toolbar.

Caution

If you want to set options for the Artistic 
Effects, click Artistic Effects Options at the 
bottom of the Artistic Effects gallery. You can 
then choose the effect you want to change 
and adjust the settings to get the result you 
want.

Tip
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Color Saturation controls
the amount of color used.

Color Tone
sets the

temperature
of the color.

Recolor a Picture

1	 Click the picture you want to change.

2	 Click the Picture Tools Format tab.

3	 Click Color in the Adjust group.

4	 Click the type of recoloring adjust-
ment you want to apply.

You can adjust settings individually by click-
ing Picture Color Options at the bottom of the 
Color gallery.

Tip
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Removing Picture Backgrounds
Many of the pictures we create include elements we’d like to 
leave out. A great picture of your dog, for example, might 
include the foot of a friend, the mess in the corner, or a prod-
uct you’d rather not showcase in your document. Word 2010 

includes a great new feature than enables you to remove the 
background of the picture so your readers’ attention is drawn 
just to the part you want them to see.

Remove Picture Background

1	 Click the picture you want to change.

2	 Click the Picture Tools Format tab.

3	 In the Adjust group, click Remove 
Background.

4	 Click Mark Areas To Keep, Mark 
Areas To Remove, or Delete Mark as 
needed to adjust the purple masking 
(this is the background area that will 
be removed).

5	 When the picture is marked the way 
you want it, click Keep Changes.

6	 To reset the picture and return 
the background, click Discard All 
Changes.

Using the Remove Background command takes 
a little practice, but it enables you to create 
some professional effects and fun pictures for 
the documents and publications you create.

Tip
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Wrapping Text Around a Graphic
When you place images, shapes, pictures, and diagrams in 
your document, you need to be able to adjust the text to make 
room for those items. Wrapping text around an item adds 
another level of polish to your document. However, using one 

of the standard text-wrapping configurations doesn’t always 
produce the desired effect. As you might expect, you can cus-
tomize the way Word wraps the text.

Set the Text Wrapping

1	 Click the picture.

2	 Click the Picture Tools Format tab and 
click the Wrap Text in the Arrange 
group. Click the text-wrapping option 
you want.

3	 Drag the picture to set its position in 
the paragraph. The text wraps around it.

4	 If the text wrapping still doesn’t 
look the way you want, click the Text 
Wrapping button again, choose More 
Layout Options from the menu, and 
make your custom layout settings 
in the Advanced Layout dialog box. 
Click OK when you’ve finished.

2
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In Line
with Text

Tight

Square

When you’re using the 
drawing canvas, set 
the text wrapping for the 
drawing canvas itself, not 
for the individual items 
on the canvas.

Tip
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Change the Wrapping Shape

1	 Click to select the item to be wrapped 
if it isn’t already selected.

2	 Click the Text Wrapping button, and 
choose either Tight or Through text 
wrapping. Click the Text Wrapping 
button again, and choose Edit Wrap 
Points from the menu.

3	 Drag a wrapping point to change the 
wrapping outline. Continue moving 
wrapping points, or drag the line to 
create a new wrapping point. 

4	 Click outside the item to deselect it.

Wrap Part of an Item

1	 Click at the point where you want to 
stop the wrap.

2	 On the Page Layout tab, click the 
Breaks button, and click the Text 
Wrapping option.

Set an item with Behind Text wrapping, move the 
item so that the text runs over it, and try to select the 
item. No luck? Click the Select button on the Home 
tab, choose Select Objects from the menu, and drag 
a selection rectangle around the item. Now you can 
move the item or change its wrap. Click the Select 
button again and click Select Objects to turn it off.

Try This!
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Arranging Multiple Graphics
When you have more than one graphic (or type of graphic) in 
your document—for example, pictures, clip art, and/or shapes 
that are meant to appear together—you can arrange them in 
whatever configuration you want. You may want to overlap 

the graphics so that one appears in front of another or group 
several items into one group so that you can move, resize, and 
copy and paste them together.

Arrange the Graphics

1	 Click a graphic and click the Picture 
Tools Format tab.

2	 Click Bring Forward or Send Back-
ward in the Arrange group to arrange 
the image.

3	 Repeat for other graphics on the 
page.

(continued on next page)

2

1 3
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Arrange the Graphics (continued)

4	 Select multiple shapes by pressing 
Ctrl and clicking each item.

5	 Click Group in the Arrange group 
to combine the shapes into a single 
object.

You can ungroup items you’ve put together by 
clicking the group, clicking the Picture Tools 
Format or Drawing Tools Format contextual tab, 
clicking the Group tool, and choosing Ungroup.

Tip
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The Align button

Gridlines display a nonprinting
layout grid on the page.

Positioning Graphics on the Page
Your readers expect to see some kind of logical order on your 
page, so no matter how great your images look, you can’t just 
put them haphazardly on the page. You can use Word 2010’s 

alignment tools to make sure your images appear just where 
you want them to in the document.

Align to the Page

1	 Select the image. Click the Picture 
Tools Format tab or the Drawing Tools 
Format tab.

2	 Click Align in the Arrange group and 
choose View Gridlines.

3	 Click the Align button again, and 
specify whether you want the graphic 
to align relative to the edge of the 
paper or to the margin.

4	 Click the Align button again, and click 
where you want to place the graphic 
on the page.

5	 To fine-tune its position, drag the 
graphic to where you want it, using 
the grid to align the graphic to other 
items.

The Drawing Tools Format tab will appear when you click a 
shape you’ve added to the page.

Tip
To change the dimensions of the layout grid or to change 
whether the graphics will automatically align to the gridlines, 
click the Align button and choose Grid Settings.
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Align Pictures with Each Other

1	 Click the pictures you want to align 
by holding down the Ctrl key as you 
click each one.

2	 Click Align.

3	 Align Selected Objects.

4	 Click the item that reflects the way 
you want the pictures to align.
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Creating Artistic Text
Word 2010 includes features that help you stylize your text in 
new ways. WordArt is a tool that has been around for a while, 
but it is more closely integrated into the workings of Word 

now. You can add all kinds of effects, curving your text words 
and phrases, creating interesting angles, shadows, and more.  

Add WordArt Elements

1	 On the Insert tab, click WordArt in 
the Text group to display the Word-
Art gallery. 

2	 Click the WordArt style you want. 

3	 A text box appears on your page with 
the format you selected. Click in the 
box.

4	 Type your text.

5	 Click outside the text box.
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You can turn regular text into WordArt by selecting the text 
before you click the WordArt tool.

Tip

Create some WordArt, select it, and then use the tools on 
the WordArt Tools Format tab to change the shape, charac-
ter spacing and height, and text alignment. Use the WordArt 
Styles gallery to apply a three-dimensional effect. Use the 3-D 
Effects tools to change the color, depth, direction, lighting, 
surface type, and 3-D angle. Amazing, isn’t it? And so much 
fun!

Try This!
You may notice that the styles available in the Text Effects 
gallery (in the Font group of the Home tab) and the styles 
available in WordArt look similar. You’re right—they do. But 
WordArt creates a text box with the phrase “Your text here,” 
and in order to edit and format the object you use the Draw-
ing Tools Format contextual tab. Text effects add and format 
the text on your document page, so the result is that the actual 
text is given the format you choose from Text Effects.

Tip
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Inserting a Relational Diagram
SmartArt is the diagramming tool in Word 2010 that makes 
it easy for you to show relationships—including comparisons, 
processes, and more—in your documents. SmartArt offers a 
number of different categories with different styles of diagrams 

you can adapt to fit what you want to show. You can also use 
pictures as part of the diagram (this is a new feature in Word 
2010) and continue to add to the diagram as your needs 
change.

Create a Diagram

1	 Click the Insert tab and click SmartArt 
in the Illustrations group.

2	 Select the type of diagram you want.

3	 Click a diagram design, review the 
information about that diagram, and 
click OK to create the diagram.

(continued on next page)

You can’t create SmartArt graphics in a Word 97–2003 format 
document. When you save a document that contains SmartArt 
in the Word 97–2003 format, the SmartArt is converted into a 
picture that you can’t modify.

Tip
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4	 Click Change Colors in the Smart 
Styles group of the SmartArt Tools 
Design tab and select the color pal-
ette you want to use.

5	 Click the first item in the Text pane 
and type the text for that item. If the 
Text pane isn’t displayed, click Text 
Pane on the SmartArt Tools Design 
tab.

6	 Continue entering text, doing any of 
the following:

•	 Press the Tab key to make the entry 
a subentry of the previous item (or 
click Demote), or Press Shift+Tab to 
elevate the entry one level (or click 
Promote).

•	 Press Enter to finish the current 
item and insert a new line for text.

•	 Press the Down arrow key to move 
to the next item.

•	 Press Delete to remove entries you 
don’t want.

4

5

6

Create a Diagram (continued)

150  Inserting a Relational Diagram



23

1

4

Modify the Diagram

1	 On the SmartArt Tools Design tab, 
point to different layouts and click 
the one that works best for your 
content.

2	 Point to different SmartArt Styles and 
click the one you want. 

3	 Use the SmartArt Tools Format tab to 
set text and shape formats.

4	 Click the frame of the diagram and 
use a Sizing handle to change the 
diagram’s size.

Create a list in your document. Select the text and copy it 
(press Ctrl+C). Insert a SmartArt diagram. Click in the Text 
pane and press Ctrl+V to paste your copied text. Edit the text, 
setting any levels you want. Point to different layouts to see 
which layout works best with your content.

Try This!
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Creating a Chart
One of the beautiful things about the various programs in 
Office 2010 is that it is so easy to use the programs together. 
When you’re working with data that you’d like to present in a 

chart, you can easily add a chart within Word that draws from 
the powerful features of Excel. The process is simple, and the 
chart will look great with just a few clicks of the mouse.

Create a Chart

1	 Click the Insert tab and click Chart in 
the Illustrations group. 

2	 Select a chart type. 

3	 Click the chart design you want and 
click OK.

(continued on next page)

If you don’t have Excel installed on your com-
puter, Microsoft Graph will start when you click 
the Chart button on the Insert tab. Microsoft 
Graph works much like Excel, although it has 
fewer features.

Tip
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Create a Chart (continued)

4	 In the Excel worksheet that appears, 
edit the sample data so that only 
your data is shown.

5	 The result of your data entry appears 
in the chart.

6	 Close the worksheet when you’ve 
finished.
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Format the Chart

1	 Click in the chart to select it if it isn’t 
already selected.

2	 If you need to modify which data is 
shown and how it’s organized, on 
the Chart Tools Design tab, click the 
Edit Data button, and make your 
modifications in the worksheet that 
appears.

3	 Use the tools on the Chart Tools 
Design tab to change the chart type, 
the data, the layout, and the overall 
appearance of the chart.

4	 Use the tools on the Chart Tools 
Layout tab to add annotations, labels, 
and other elements.

5	 Use the tools on the Chart Tools 
Format tab to format individual items 
in the chart. 

6	 Save the document to save the data 
and the design of the chart.

Although the Excel worksheet looks like a standard worksheet, 
it’s actually a special Excel object that’s stored in your Word 
file. All your chart information and data are stored in the Word 
file, so you don’t need to access the Excel file to view or modify 
the chart in Word.

Tip
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In this section:

Customizing and 
Securing Word

One of the great things about Microsoft Word 2010 is that 
not only does it pack a lot of power into the various features 

and tools at your fingertips, but it also allows you to customize 
those tools so you have just what you want nearby when you 
want it. You can easily customize the ribbon by adding tabs, tab 
groups, and tools; you can customize the Quick Access Toolbar 
by changing the tools it displays and changing where in the 
document window it appears. What’s more, you can change 
other preferences, such as the way the screen looks, the way your 
files are saved, and much more.

Another important story in Word 2010 is the enhanced 
security that occurs largely without your even noticing it. Behind 
the scenes, Word 2010 is working to ensure that the files you 
receive and open have been checked—thoroughly—for any 
possible risk. You can set the types of files you want to be 
blocked in your version of Word and tell the program when you 
want Protected View to intervene and safeguard your files and 
when it’s okay to open them directly. These security features—
and more—are the topic of this section.

10
■■ Customizing the Ribbon

■■ Customizing the Quick Access Toolbar

■■ Customizing the Work Area

■■ Creating Macros

■■ Safeguarding a Document

■■ Recovering Unsaved Versions of a File

■■ Restricting Access and Changes to a 
Document

■■ Digitally Signing a Document 

■■ Protecting a Document with a 
Password



Customizing the Ribbon
You probably remember all the excitement around the intro-
duction of the ribbon, which was offered for the first time with 
Office 2007. Some people were thrilled, others were dismayed, 
and most Word users simply figured out how to master the 
interface and gradually grew to like it. Word 2010 includes 

a new feature that is huge to Word users who want to have 
within clicking distance the tools they use most often. Now you 
can customize the ribbon to include tabs you create. And you 
can add your own groups and tools to those tabs in whatever 
order makes sense to you.

Create and Rename a New Tab

1	 Click the File tab to display Backstage 
view.

2	 Click Options.

(continued on next page)

1

2
By default a new group is created when 
you add a new tab. You can add additional 
groups to the tab by clicking New Group at 
the bottom of the Customize The Ribbon list.

Tip
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You can move the group you create 
up or down through the tabs shown 
by clicking the Move Down or Move 
Up buttons.

Tip

Create and Rename a New Tab (continued)

3	 Click Customize Ribbon.

4	 Click New Tab.

5	 Click the new tab.

6	 Click Rename.

7	 Type a new name for the tab and 
click OK.
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Rename and Add Tools to the 
Group

1	 Click the new group that was created 
automatically.

2	 Click Rename.

3	 Type a name for the group and click 
OK.

(continued on next page)
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If you don’t see the tools you want in the Popular Commands 
list, click the Choose Commands From arrow, and choose All 
Commands. Scroll through the list to find the tool you want, 
click it, and click Add.

Tip
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Rename and Add Tools to the 
Group (continued)

4	 In the Choose Commands From list, 
click the tool you want to add to the 
group.

5	 Click Add.

6	 Repeat Steps 4 and 5 as needed until 
you have added all the tools you 
want.

7	 Click OK.

In addition to selecting the tool and clicking Add, you can add 
a new tool to the group by simply dragging it from one list to 
another. 

Tip

If you use more than one computer and 
want to use your customized ribbon on 
another machine, click the Import/Export 
button in the lower-right corner of the 
Customize Ribbon dialog box. Choose 
Export All Customizations to create a file 
you can add to other computers. When 
you move the file to the new computer, 
use Import Customization File to import 
your changed ribbon settings.

Tip
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Customizing the Quick Access Toolbar
The Quick Access Toolbar makes it easy for you to have the 
tools you want to access quickly nearby no matter which Word 
tabs you may be using. If you put so many items on the Quick 

Access Toolbar that it becomes too big to fit on the title bar, 
you can move it to its own line.

Add or Remove Items Common to 
the Quick Access Toolbar

1	 Click the down arrow at the right of 
the Quick Access Toolbar. 

2	 On the Customize Quick Access Tool-
bar menu, click any checked items 
that you want to remove from the 
toolbar.

3	 Click any unchecked items that you 
want to add to the toolbar.

4	 Right-click any item anywhere on the 
ribbon that you want to add to the 
toolbar, and choose Add To Quick 
Access Toolbar from the shortcut 
menu.

5	 If the toolbar becomes too large to 
fit on the title bar or if you want to 
change the location of the bar, click 
the down arrow at the right of the 
toolbar and click Show Below The 
Ribbon on the menu.
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The Quick Access toolbar
on its own line below

the ribbon

You can return the Quick Access Toolbar to its spot above the 
ribbon by clicking the Quick Access Toolbar arrow and choos-
ing Show Above The Ribbon.

Tip
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Control the Customization

1	 Click the Quick Access Toolbar arrow 
and click More Commands to display 
the Word Options dialog box with the 
Customize Ribbon category selected 
in the left pane.

2	 Specify the category of commands 
you want to select from.

3	 Click a command you want to add to 
the toolbar.

4	 Click Add.

5	 To remove a command you don’t use, 
select it and click Remove.

6	 To change the order in which com-
mands will appear on the toolbar, 
click a command and use the up or 
down arrow to move the command.

7	 Repeat steps 3 through 7 to make any 
further customizations to the Quick 
Access Toolbar; click OK when you’ve 
finished.

1 2 4

5 7

3 6

You’re not limited to “standard” Word commands. You can 
include styles, fonts, and macros on the toolbar.

Tip

When you change the Quick Access Toolbar, the changes you 
make appear in the toolbar in all your documents. If you want 
to use that version of the toolbar in the current document only, 
display the Word Options dialog box, click Quick Access Tool-
bar, and click the Customize Quick Access Toolbar arrow and 
choose the name of your current document. Click OK to save 
your changes.

Tip
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Customizing the Work Area
The work area is where you create, edit, format, and fine-tune 
the documents you create in Word 2010, so you may want to 
customize it to fit your own preferences. You can show or hide 

items on the status bar, set the ribbon to appear only when you 
need to use it, change the overall color scheme for the window, 
and so on.

Show or Hide Items on the  
Status Bar

1	 Right-click anywhere on the status 
bar.

2	 Review the information on the 
Customize Status Bar menu.

3	 To show an item that isn’t currently 
displayed on the status bar, click the 
item.

4	 To hide an item that’s currently dis-
played, click the item.
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Change the Color Scheme

1	 Click the File tab and click Options to 
display the Word Options dialog box. 

2	 In the General tab, click Color Scheme 
and click the color you want.

3	 Click OK.
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Show or Minimize the Ribbon

1	 Click the Minimize The ribbon button 
at the top right of the ribbon.

2	 Display the ribbon by clicking the tab 
you want. Click a tab when you want 
to display the ribbon and choose the 
tool you want. The ribbon is then 
hidden again.

3	 To redisplay the ribbon, click Maxi-
mize The Ribbon.

With the ribbon displayed, double-click the 
active tab to minimize the ribbon, and then click 
any tab to display the ribbon temporarily. Click 
in your document to minimize the ribbon again. 
Double-click the active tab to redisplay the 
ribbon. Press Ctrl+F1 to hide the ribbon, and 
press Ctrl+F1 again to always display the ribbon.

Try This!
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Changing the Location and Type of Saved Files
If you want to save your documents in specific folders, you can 
have Word change the places your files are saved by default. 
You set file locations and formats using the Word Options 
dialog box. What’s more, you can choose to save your Word 
files in a previous version if you like, in case you work with 

peers and friends who are using a previous version of Word. 
(Note, however, that if you work in a version of Word prior to 
2007, many of the new features—including artistic effects, 
collaborative tools, and more—won’t be available in the earlier 
format.)

Change the File Locations and 
Formats

1	 Click the File tab, click Options and 
click Advanced. Scroll down to the 
General area and click the File Loca-
tions button to display the File  
Locations dialog box.

2	 Click the item whose location you 
want to change.

3	 Click Modify, and, in the Modify 
Location dialog box, locate and select 
the folder that you’re designating as 
the new location; click OK.

4	 Specify the location for any other 
file types and click OK when you’ve 
finished.

5	 Click the Save category.

6	 Select the default format in which 
you want to save your documents.

7	 Click OK to close the Word Options 
dialog box.
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If you consistently save your files in a 
format other than the Word 2010 for-
mat, you should modify the Compat-
ibility settings on the Advanced tab of 
the Word Options dialog box so that 
your documents have the correct lay-
out for the format in which you save 
them.

Tip
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Customizing Your Spelling Dictionaries
Word 2010 enables you to use one or more dictionaries to 
check your spelling. When there’s a word in your document 
that’s correct but that Word doesn’t recognize—a name, an 
address, or an unfamiliar technical or scientific term, for 
example—you can tell Word to add that word to your custom 
dictionary. If you already have a custom dictionary that 

includes many of the words you want Word to recognize as 
correct, you can add that dictionary to the list of dictionaries 
that Word is using. Now in Word 2010 you can also choose a 
dictionary in another language if you are translating or editing 
in a language other than English.

Add a Dictionary

1	 Click the File tab and click Options to display 
the Word Options dialog box.

2	 Click Proofing. 

3	 Click the Custom Dictionaries button to display 
the Custom Dictionaries dialog box.

4	 If you have an existing dictionary that you 
want to use, click Add; in the Add Custom 
Dictionary dialog box that appears, locate the 
dictionary file. Click Open.

5	 To create a dictionary by adding entries, click 
New, use the Create Custom Dictionary dialog 
box to name the dictionary file, and click Save.

6	 To add or delete words in a dictionary, select 
the dictionary, and click Edit Word List.

7	 Click Add and type a word, or select a word 
you want to remove and click Delete.

8	 Click OK.

9	 Verify that the dictionaries you want to use 
are checked and those you don’t want to use 
aren’t checked.

10	 Click OK.
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Creating a Macro
You can automate procedures you follow often by creating a 
macro to record the keystrokes and menu selections and then 
playing them back by pressing a single key combination. For 
example, you could create a macro by recording the replacement 

of a phrase and/or a style using the Replace command. Then 
you can run that macro to modify other documents. Regardless 
of the complexity of your macro, you can run it as though it 
were a single Word command.  

Create a Macro

1	 Click the View tab, click the Macros arrow in 
the Macros group, and choose Record Macro 
to display the Record Macro dialog box.

2	 Type a name for the macro. (The name must 
begin with a letter and can’t contain any 
spaces or symbols.)

3	 Choose whether you want to assign the 
macro to a button or the keyboard.

4	 Specify where you want to store the macro 
and type a description.

5	 Click OK.

6	 Execute the series of actions you want to 
record as a macro, using your keyboard to 
select text and to move the insertion point. 
(Note that other than when you click a com-
mand, most mouse actions aren’t recorded.)

7	 When you’ve completed the series of actions, 
click the Macros arrow again and choose 
Stop Recording.

8	 Click Macros to display the Macros dialog 
box, select the macro you just recorded and 
click Run to make sure the macro performs 
correctly. 

1

2

5

3

4 7

For the greatest control in creating and modifying macros, 
add the Developer tab to the ribbon by clicking the File tab, 
clicking Options, clicking Customize Ribbon, and clicking the 
Developer tab check box in the list on the right. Click OK to 
save your changes.

Tip
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Understanding Security in Office 2010
Today you just can’t be too careful about the files you accept 
and download from the Internet. Every computer user needs 
some sort of antivirus program that scans incoming files for 
potential threats and keeps your computer safe from attack. 
Word 2010 includes improved security features that evaluate 
files before you open them and then prompting you if some-
thing unrecognized is found.

One area developers found vulnerable to attack occurs 
when you open a file saved in a previous version of Word. To 
safeguard this process, Word now includes a security check 
that goes on behind the scenes when you open a new 

document. The file must pass a series of checks—called a file 
validation process—before it is considered a safe file. If Word 
2010 finds anything suspicious, the document is displayed in 
Protected View.

Word 2010 shows you that a file is in Protected View by 
displaying a message bar across the top of the work area. If 
you know the sender of the file or are certain the file is safe, 
you can click Enable Editing to remove the protection and edit 
the file normally. You can change which files Word 2010 flags 
for protection by changing the settings in the Trust Center.

Customizing and Securing Word
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Working with the Trust Center
You use the Trust Center to set up your preferences for the 
way your files are opened, shared, and protected. You can 
create lists of trusted publishers, documents, and locations 
that don’t have to be authenticated each time you receive a 
document from them. 

You’ll find the Trust Center by clicking the File tab and 
clicking Options. At the bottom of the category list, click Trust 
Center and then click Trust Center Settings. The Active X tab 
opens by default so that you can review those settings. The 
following table explains each of the categories in the Trust 
Center and explains how you can use those options to safe-
guard your files.

Word 2010 Trust Center

Category Description

Trusted Publishers Enables you to create a list of publishers you trust so that any content you receive from the publisher is 
opened freely without restriction.

Trusted Locations Gives you the ability to create a list of trustworthy locations—for example, share folders and SharePoint 
Workspaces.

Trusted Documents Creates a list of documents you have specified as trusted. After a document is marked as trusted, macros 
and all content is enabled automatically.

Add-Ins Enables you to specify whether any application add-ins must be signed by a trusted publisher.

Active X Settings Lets you choose whether ActiveX controls will be allowed to play in regular mode or in safe mode. You 
also set the level of restriction for the running of the controls.

Macro Settings Sets whether macros are automatically disabled or enabled.

Protected View Enables you to choose the situations in which Protected View is used.

Message Bar Lets you show or hide the Message Bar.

File Block Settings Gives you the ability to choose whether specific file types are blocked from being open or saved.

Privacy Options Lets you set privacy options for the current file.
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Changing File Validation
You can tell Word 2010 which file types you want to validate 
before opening the files. This controls when Protected View is 
used to safeguard files that you are opening. You can choose 

that files be checked when you open a file, save a file, or both. 
The following table introduces the different settings you can 
choose for file validation.

Set File Types

1	 Click the File tab and click Options to display 
the Word Options dialog box.

2	 Click Trust Center.

3	 Click the Trust Center Settings button.

4	 Click the File Block Settings category.

5	 Click to clear the check mark in any file type 
you don’t want to check.

6	 Click to add a check mark in the Open and 
Save columns for those file types you do 
want to check. 

7	 Click OK.

File Block Behaviors

Setting Description

Do Not Open Selected File 
Types

The selected files are blocked and will 
not be opened.

Open Selected File Types In 
Protected View

Opens the selected file in a safe mode 
that is protected from other files and 
processes.

Open Selected File Types In 
Protected View And Allow 
Editing

Opens the selected file type in safe 
mode but allows the user to edit 
normally.

1

2

3

7

4
5

6
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Choosing What’s Displayed in Protected View
The Protected View message bar appears when you have tried 
to open a file that has either been blocked or has been deter-
mined to be in a file format flagged for blocking. If you want 
to see the contents of the file or know the person or company 
who sent it, you can open the file in Protected View. Protected 
View is a safe mode that enables you to view the file without it 

potentially affecting your other files. When you know the file is 
okay, you can click Enable Editing to open the file normally. 

Word 2010 enables you to choose when Protected View is 
used for your files. You’ll find the settings for Protected View in 
the Protected View category in the Trust Center.

Set Protected View Settings

1	 Click the File tab and click Options to 
display the Word Options dialog box.

2	 Click Trust Center and click Trust 
Center Settings.

3	 Select Protected View.

4	 Click to remove the check mark of 
any setting you do not want to keep.

5	 Click OK.

You can modify the settings at any time. If you later want to 
restore a protection you removed, simply display the Protected 
View category again and click the check mark to return the 
check.

Tip

1

2

5

3

4
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Password Protecting a File
Office 2010, like its predecessors, makes it easy for you add 
passwords to your Word, Excel, and PowerPoint files. Now 

in Office 2010, you can add encryption to your password to 
ensure that your file is as secure as possible.

Add a Password

1	 Click the File tab.

2	 In the Info tab, click Protect Docu-
ment in the Permissions area.

3	 Click Encrypt with a Password.

4	 Enter a password and click OK.

1 2

3

4

Note that when you set an encrypted password for your Word 
file, the password cannot be recovered if you forget the pass-
word later. For this reason, you should keep a copy of your 
passwords in a safe place you can access easily.

CautionYou can also set the password during the Save As process by 
clicking (in the Save As dialog box) the Tools arrow, choosing 
General Options, and entering the password required to open 
the file. If you plan to share the file with others, you can enter 
a separate password that you share with co-authors to enable 
modification and file sharing.

Tip
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Limiting File Changes
Not only do you need to make sure that the files you open 
are safe, but you also need to be able to protect the files you 
create so that people can change only what you want them to 
change in the file. You can set protection levels on individual 

files that make it possible for you to limit editing in a docu-
ment, for example, or protect sections or the structure of a 
worksheet, so that others’ ability to change the content of the 
file is limited.

Set File Permissions

1	 Click the File tab.

2	 In the Info tab, click Protect 
Document.

3	 Click Restrict Editing to control the 
types of editing that can be done in 
the file.

(continued on next page)

1 2

3

Formatting restrictions limit users to chang-
ing styles used in the document, and editing 
restrictions enable you to specify whether you 
want users to view the file as read-only, or if you 
will allow them to enter tracked changes, com-
ments, or complete forms.

Tip
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Word gives you the option of adding a digital signature to your 
document to verify a document’s integrity. The digital signa-
ture feature in each of these applications requires a signature 
service from a third-party vendor. You can begin the process 
by clicking Add A Digital Signature in the Protect Document 
selection of the Info tab, and a prompt will offer you the option 
of finding a signature service on Office Marketplace. Note that 
Protect Document is not available if you are using Compatibil-
ity Mode—you must first save the document as a Word 2010 
file before Protect Document becomes available.

Tip

You can also limit the access others have to your files by 
restricting the permissions they have based on their role. The 
Restrict Permission By People option in the Protect Docu-
ment settings in the Info tab (in Backstage view) enable you 
to choose the group of people who you want to give access to 
your document. 

Tip

Set File Permissions (continued)

4	 Click the Allow Only This Type Of 
Editing In The Document check box.

5	 Click the type of change you want to 
allow.

6	 Indicate who these changes apply to.

7	 Click Yes, Start Enforcing Protection.
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Recovering Unsaved Versions
Have you ever made great changes to a document and then 
accidentally closed the file without saving? One of the great 
new safety-net features in Word 2010 is your file is saved 
for you in case you forget. Because the program stores your 

unsaved files automatically, you can return to a previous ver-
sion if you need to find information you accidentally deleted or 
items you revised in error. 

Recover Unsaved Files

1	 Click the File tab.

2	 Click Manage Versions.

3	 Click Recover Unsaved Versions.

4	 Select the file you want and click 
Open.

You can also display unsaved documents from 
the Recent category. Scroll to the bottom of 
the Recent Documents list and click Recover 
Unsaved Documents. Double-click the file you 
want to view in the Open dialog box.

Tip

If you open an autosaved document that is not 
the most current version available, Word 2010 
lets you know about the status of the file. Click 
whether you’d like to compare the autosaved 
version with your current document or restore 
the autosaved file to full editing capabilities.

Tip
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Symbols
97-2003 Word Document format, 159–160
97-2003 Word Template Document 

format, 159
2003 XML Document format, 159
? wildcard, 39
* wildcard, 39

A
About This Sentence (grammar), 51
Add Text tool, 190
Adjustment handle (shapes), 136
alignment

of graphics to pages, 146–147
of paragraphs, 83
of pictures, 146–147
of tables, 122
of text in tables, 117

Allow Typing option, 42
Apply Styles window, 66
Arrange All function, 211
art borders around pages, 93
Artistic Effects (pictures), 139–140
artistic text, creating, 148
Aspect Ratio, setting, 133
At Least option (paragraph formatting), 80
attachments to e-mails, displaying, 42
AutoCorrect feature, 52–55
AutoCorrect Options button, 72
automatically inserted hyperlinks, 23
automatic text correction, 52–54
autosaved documents, 234

B
backgrounds, removing picture, 141
Backstage view, 15, 18–20, 27
Behind Text wrapping, 143
blogs, writing/publishing, 164–166
blue squiggles, 51
borders

adding to paragraphs, 95
around pages, 92
art borders around pages, 93
Borders And Shading dialog box, 96
Borders tool, 124

bound documents, setting up, 103
breaking manually, defined, 106
Browse For Themes option, 63
browser icon, 9
Browse tools, 24
building blocks, creating/inserting, 48–49
bulleted/numbered lists

creating, 71
customizing, 73–74
list styles and, 61

business documents, styles and, 68

C
cells, dividing (tables), 121
center alignment of text, 83
Change Styles tool, 68
character formatting

applying, 69
copying, 91

characters
adjusting space between, 82
styling, 61
wildcard, 39

charts
Chart tool, 129
Chart Tools Design tab, 154
creating, 152–154

Check For Updates function, 27
Clear All option (Clipboard), 46
Clear Formatting tool, 79
clip art, 128, 134
Clipboards, Windows & Office, 34, 44–46
Clip Organizer, 130
co-authoring documents, 4, 200–203
Collapse Subdocument function, 186
colors

Color gallery, 140
Color Scheme, changing, 222

columns, adding to documents, 110
columns and rows (tables)

adding/deleting, 115–116
sizing, 120

command tabs, 8
comparing changes in documents, 

208–209
compatibility

Compatibility Checker, 40
Compatibility Mode, 40, 233
settings, 224

compiling indexes, 193
conditional content

form letters and, 173
setting (mail merge), 169

contacting co-authors, 203
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content
adding to documents, 20–22
conditional (form letters), 173
content controls (fields), 101
setting conditional (mail merge), 169

Contextual tab, 9
converting

documents between Word versions, 
40–41

table text to regular text, 114
copying/cutting/pasting text, 34–35, 

44–46
copying paragraph formatting, 91
cover pages, 187
cropping pictures, 132–133
cross-references (indexes), 193
Ctrl key for hyperlinks, 24
customizing

bulleted/numbered lists, 73–74
charts, 129
Customize Ribbon dialog box, 219
Custom Margins option, 103
multilevel lists, 77
Quick Access Toolbar, 220–221
ribbon, 216–219
table layouts, 119
templates, 98–99
Word 2010, 4
work area, 222–223

D
Date And Time tool, 101
Decimal tab stop, 117
decorative horizontal lines, 94
deleting rows/columns, 116
designing templates, 100–101
Developer tab, adding to ribbon, 226

diagrams
relational, 149–151
SmartArt, 151

dictionaries, spelling, 225
digital signatures, 233
direct formatting

defined, 62
vs. styles, 83

discontinuous numbered lists, 72
Distribute Rows function (tables), 119
documents. See also files

adding content to, 20–22
adding content with ink function, 22
adding hyperlinks to, 23–24
autosaved, 234
co-authoring, 200–203
composing different types of, 156–157
converting old, 40–41
cover pages, 187
creating new, 12–14
creating/posting online, 160–163
creating with templates, 15–16
dividing into sections, 108
Document Inspector dialog box, 213
Document tab, 37
finalizing, 212–213
formatting with themes/styles/fonts, 

60–62
indexes, creating, 192–193
inserting files in, 162
inserting pictures in, 130–131
inserting text files in, 21
linking, 24
master documents, 186
navigating, 36–38, 43
opening as copy, 17
opening existing, 17
opening existing as templates, 15
opening in Windows Live SkyDrive, 199

opening recently used, 18
Outline view, 183–185
page setup for electronic viewing, 156
previewing, 25
printing, 25–26
reading through, 42
reorganizing, 183–185
reviewing. See reviewing documents
saving, 14
saving to shared spaces, 198
setting margins, 102
table of contents, 190–191
viewing side by side, 211

Draft view, 8, 11, 188, 206
drag and drop text function, 20
drawing

content (ink function), 22
drawing canvas, 142
Drawing Tools Format contextual tab, 

145
Drawing Tools Format tab, 146
Draw Table tool, 121
shapes, 135–136
text boxes, 87

drop caps, creating, 90

E
editing

Edit Header function, 109
Editing group (Home tab), 38
Edit Recipient List (form letters), 171
headers and footers, 177
pictures, 137, 137–138
restrictions on, 232
summary of methods for, 34–35
text, 30–32

Effects, Theme, 65
electronic postage, 167
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e-mail addresses/links, adding, 160
Enable Live Preview check box, 67
encrypted passwords, 231
endnotes. See footnotes and endnotes
envelopes, printing, 167
Eraser tool, 121
Esc key, 31
even-page headers and footers, 179
Exactly option (paragraph formatting), 80
Excel 2010

dragging/dropping content from, 20
inserting charts from, 152–154

Expand Subdocuments function, 186
Export All Customizations function 

(ribbon), 219

F
fields, template, 101
file formats

for pictures, 130
Word 2010, 158–159

files. See also documents
adding content to, 20–22
adding hyperlinks to, 23–24
changing location/formats of saved, 224
changing validation of, 229
converting old, 40–41
creating within files (online), 162–163
designing templates based on existing, 

100
File Block behaviors, 229
File tab, 13, 17, 25, 26
and folders, pinning, 18
formatting with themes/styles/fonts, 

60–62
limiting changes to, 232–233
naming, 14
navigating through, 36–38

opening, 17
opening as copy, 17
opening recently used, 18
password protecting, 231
permissions, setting, 232–233
printing, 25–26
reading, 42–43
recovering unsaved, 234
reviewing shared file information, 204
saving, 14
shared (co-authoring), 204–205

finalizing documents, 212–213
Find And Replace dialog box, 39
Find tool, 38
First Line Indent marker, 84
fonts

Font dialog box, 82
formatting, 78–79
Theme Fonts, 65

footers. See headers and footers
footnotes and endnotes, 188–189
Format Horizontal Line dialog box, 94
Format Painter tool, 62, 91
formats, file. See file formats
formatting

characters, 69
charts, 154
copying formatting, 91
direct formatting, 62
documents with themes/styles/fonts, 

60–62
fonts, 78–79
Format Shape button, 138
pictures, 137–138
restrictions on, 232
tables, 124
with tabs, 85–86
text, 69–70

form letters, 170–174
Full Screen Reading view, 8, 10, 33, 42

G
Gabriola font, 82
gallery example (illustration), 9
General tab, 222
Go To Footer tool, 109
grammar

correcting, 51
Grammar checker, 50

graphics
arranging multiple, 144–145
Artistic Effects, 139–140
charts, 152–154
Chart tool, 129
clip art, 128, 134
picture backgrounds, removing, 141
pictures, changing size of, 132–133
pictures, editing/formatting, 137–138
pictures, inserting, 130–131
Picture tool, 128
positioning on pages, 146–147
relational diagrams, 149–151
screenshots, 129
shapes, 128–129, 135–136
SmartArt, 129
WordArt, 148
wrapping text around, 142–143

green squiggles, 51
gridlines, 33, 121, 146
Grid Setting (Align button), 146
groups (custom tabs), 218–219
Group tool, 145
Grow Font tool, 79
gutters, 102–103
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H
headers and footers

changing running heads, 109
creating, 176
editing, 177
Header & Footer Tools Design tab, 109
linking and unlinking, 180
variable, 178–179

headings, navigating documents by, 36
Help

Help dialog box, 27
icon (illustration), 9

Hide Folders function, 14
Highlight tool, 207
Home Page button (Blogs), 166
Home tab, 8, 13, 38, 47
horizontal lines, decorative, 94
hyperlinks, adding to documents, 23–24
hyphenation, adjusting, 107

I
illustrations

art borders around pages, 93
artistic text, creating, 148
automatic text correction, 52
Backstage view, 18–19
borders/shading, adding to paragraphs, 

95–96
building blocks, inserting, 48–49
bulleted and numbered lists, 71–72
character fonts/sizes, changing, 78–79
character formatting, copying, 91
charts, creating, 152–153
co-authoring documents, 200–203
columns, adding to documents, 110
columns/rows, sizing, 120

composing types of documents, 
156–157

content, adding with Ink function, 22
converting old documents, 41
copying/moving text, 44
copying/pasting multiple items, 46
cover pages, inserting, 187
customizing bulleted/numbered lists, 73
customizing multilevel lists, 77
decorative horizontal lines, 94
direct formatting, 62
discontinuous numbered lists, 72
dividing table cells, 121
documents, comparing changes in, 

208–209
documents, creating new, 12–13
document sections, 108
documents, finalizing, 212
documents, opening, 17
documents, opening in Live SkyDrive, 

199
documents, reorganizing, 183–185
documents, saving, 14
documents, saving to shared spaces, 

198
documents, viewing side by side, 211
drag and drop text, 20
drop caps, 90
File Block settings, 229
file locations/formats, changing, 224
file permissions, setting, 232–233
finding/inserting Clip Art, 134
footnotes and endnotes, 188–189
formatting text, 69
formatting with tabs, 85
form letters, 170–173
grammar, correcting, 51
graphics, positioning on pages, 146
headers and footers, 176–180

hyperlinks, adding to documents, 23
hyphenation, adjusting, 107
indenting paragraphs, 84
indexes, creating/compiling, 192–193
laying out pages, 102–103
line borders around pages, 92
linking documents, 24
linking text box text, 89
list numbering schemes, changing, 74
macros, creating, 226
margins in documents, changing, 

105–106
master documents, creating, 186
Mini Translator, 57
multilevel lists, 75–76
multiple graphics, arranging, 144–145
navigating through documents, 36
online documents, creating, 160–161
page orientation, changing, 104
paragraph alignment, 83
paragraph line spacing, adjusting, 

80–81
password protecting files, 231
pasting text, 45
picture backgrounds, removing, 141
pictures, applying Artistic Effects to, 139
pictures, changing size of, 132–133
pictures, editing/formatting, 137–138
pictures, inserting in documents, 131
predesigned tables, 113
predesigned text boxes, 87
printing documents, 25
printing envelopes, 167
Protected View settings, 230
Quick Access Toolbar, customizing, 

220–221
reading documents, 42
relational diagrams, inserting, 149–150
researching subjects, 55
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revision marks, 206
ribbon, customizing, 216–219
running heads, 109
shapes, drawing, 135–136
spacing between characters, 82
spelling dictionaries, customizing, 225
spelling errors, correcting, 50
styles, applying/saving, 66–67
style sets, changing, 68
styles, types of, 61
table of contents, creating, 190–191
table rows/columns, adding/deleting, 

115–116
tables, aligning, 122
tables and lists, sorting, 181
tables, creating, 111
tables, creating from text, 114
tables, formatting, 124
tables, moving, 123
tables, positioning elements in, 117–118
tables, sizing, 119
table styles, creating, 125
tab stops, modifying, 86
templates, choosing, 15–16
templates, customizing, 98–99
templates, designing, 100–101
text boxes, 87
text files, inserting, 21
text flow, adjusting, 106
text, replacing, 47
text, searching/finding, 38
text, selecting/modifying, 30
text, translating, 56
text, wrapping, 142–143
themes, formatting documents with, 60
themes, previewing/choosing, 63
thumbnails, viewing, 37
unsaved files, recovering, 234
views, setting, 33

Word 2010 views, 10–11
Word 2010 window, 8
Word Help, 27
work area, customizing, 222–223
writing/publishing blogs, 164–166

Illustrations group, 128
Include Content From Office Online check 

box, 73
Increase Text Size option, 42
indenting paragraphs, 84
indent markers, 8
indents, adjusting list, 76
indexes, creating, 192–193
information, organizing with tables/lists, 

181–182
Info tab, 18–19, 41
ink function, 22
inserting

building blocks, 48–49
charts from Excel, 152–154
Clip Art, 134
cover pages, 187
files in documents, 162
Insert Category button (Blogs), 166
Insert Hyperlink dialog box, 24
Insert Merge Field dialog box (mail 

merge), 172
Insert tab, 128, 131
pictures in documents, 131
predesigned text boxes, 87–88
relational diagrams, 149–150
tabs in table cells, 111
text files, 21

J
Joyce, Jerry, 5
justifying paragraphs, 83

K
Keep On Top button, 27
Keep Source Formatting (pasting), 45
Keep Text Only (pasting), 45
kerning characters, 82
keyboard shortcuts

copying/moving text, 35
editing text, 31–32
Find And Replace dialog box, 39
formatting text, 70
hiding/displaying ribbon, 223
Hyperlinks, 160
Insert Hyperlink dialog box, 24
inserting tabs in table cells, 111
line spacing, 80
moving between list levels, 75
moving between table cells, 111
moving to top of documents, 178
Research task pane, 55
saving files, 14
selecting text, 34
selecting text in linked text boxes, 89

KeyTips, 31

L
Labels tab (mailing), 168
Landscape Orientation, 102, 104
languages, translation, 56
layouts, page. See page layouts
leaders for tab stops, 86
Left Indent marker, 84
legal blacklining, 208
letters, form. See form letters
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lines
decorative horizontal, 94
Line And Page Breaks tab, 106
line borders around pages, 92
Line Spacing tool, 81
line status bar, 8
spacing between paragraphs, 81
spacing within paragraphs, 80

linking
documents, 24
headers and footers, 180
linked styles, 61
Link To File function, 131
Link To Previous tool, 180
text box text, 89

lists
bulleted/numbered, 71, 73–74
discontinuous numbered, 72
list styles, 61
multilevel. See multilevel lists
sorting, 182

Live Preview feature, 67

M
macros

creating, 226
Macro-Enabled Document format, 158
Macro-Enabled Template Word 

Document format, 158
magnifying text with Zoom control, 12
mailing labels, printing, 168
Mailings tab, 167, 169, 171
Mail Merge, 169–172
Manage Accounts button (Blogs), 166
Manage Versions (Backstage view), 19
manual breaking, defined, 106
manual column breaks, 110
manual page breaks, 107

margins
changing in documents, 105
markers, 8
setting in documents, 102

marked up inserted text (illustration), 9
Mark Entry tool (indexes), 192
Mark Index Entry dialog box, 193
markup area (illustration), 9
master documents, creating, 186
Match Destination Formatting (pasting), 

45
Merge Formatting (pasting), 45
merging. See also Mail Merge

cells (tables), 121
documents (reviewing), 210

Microsoft Graph, 152
Microsoft Office 2010 Upload Center, 197
Microsoft Office Picture Manager, 130
Microsoft SharePoint Workspace 2010, 

196–197
Microsoft Windows 7 Plain & Simple, 5
Microsoft Works database, 169
Mini toolbar (selected text), 78
Mini Translator, 57
Mirror Indents option, 84
modifying

Modify Location dialog box, 224
templates, 99
themes, 65

Moon, Marianne, 5
Move pointer, 120
moving

paragraphs, 184
sections (text), 185

multilevel lists
creating, 75
customizing, 77
styles, choosing, 76

multiple graphics, arranging, 144–145

Multiple Pages settings, 103
Multiply option (paragraph formatting), 

80
My Templates icon, 15

N
naming files, 14
navigating documents, 36–38, 43
Navigation pane, 33
nesting tables, 122
numbered/bulleted lists

creating, 71
customizing, 73–74
list styles and, 61

Numbering gallery (lists), 74

O
Object tool (Text group), 162
odd-page headers and footers, 179
odd-page section breaks, 109
Office 2010

Clipboard, 44
Compatibility pack, 41
security in, 227

Office Clipboard, 34
Office.com, 15, 73
Office Marketplace, 233
OneNote notebooks, 25, 26
online documents

creating, 160–163
including files within files, 162–163

opening
documents in Live SkyDrive, 199
existing documents, 17
recently used files, 18
templates, 98
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OpenType settings, 82
orientation of pages, 104
Orientation option (pages setup), 102
orphans, defined (text), 106
outline of this book, 3–4
Outline view, 8, 11, 183–185, 188, 190
Outlining tab, 186
Outlook Contacts list (form letters), 170
Overtype mode (text), 30

P
page layouts

bound documents, 103
changing page orientation, 104
columns, adding, 110
hyphenation, 107
margins, 105
Page Layout view, 206
page orientation, 104
running heads, 109
sections, creating, 108
standard page setup, 102
tables. See tables
templates. See templates
text flow, adjusting, 106
two-sided document setup, 103

page numbers (illustration), 9
pages

art borders around, 93
line borders around, 92
page borders, creating, 92
page breaks, manual, 107
Page Setup dialog box, 25, 86, 102
positioning graphics on, 146

paragraphs
adding borders to, 95
adding shading to, 96
copying paragraph formatting, 91

indenting, 84
moving in Outline view, 184
Paragraph dialog box, 86
paragraph marks, 9, 157
paragraph styles, 61
setting alignment of, 83
setting line spacing between, 81
setting line spacing within, 80

password protecting files, 231
pasting

multiple items, 46
Paste with Live Preview function, 44
text, 45–46

permissions
setting, 18
setting co-author, 200
setting for files, 232–233

personalizing form letters, 172–173
pictures

aligning, 146–147
Artistic Effects, 139–140
changing size of, 132–133
editing/formatting, 137–138
inserting in documents, 130–131
Picture Bullet dialog box, 73
picture file formats, 130
Picture Manager, Microsoft Office, 130
Picture Options dialog box, 165
Picture tool, 128
Picture Tools contextual tab, 9
Picture Tools Format tab, 132, 133, 137
recoloring, 140
removing backgrounds from, 141
Reset Picture button, 139

pinning files/folders, 18
Plain Text Document format, 159
Play feature (translations), 57
points, defined (fonts), 80
Popular Commands list, 218

Portrait Orientation, 102, 104
positioning graphics on pages, 146–147
predesigned tables, 113
predesigned text boxes, 87–88
previewing

documents, 25
Preview Results button (form letters), 

172
themes, 63

printing
documents, 25–26
envelopes, 167
mailing labels, 168
Print Layout view, 8, 10, 123, 176, 187, 

191
Print Preview, 25

Proofing Errors icon, 51
Proofing option (Word Options dialog), 53
Protect Document function, 212
Protect Document settings, 233
Protected View, 227, 229–230
publishing blogs, 164
pull quotes, 87

Q
Quick Access Toolbar

customizing, 220–221
Save button, 14

Quick Parts feature, 48–49
Quick Styles

for consistent font formatting, 78
feature, 3
gallery, 66

Quick Tables, 113



242  reading documents

R
reading documents, 42
read-only files, 17, 232
Recent Documents list, 234
Recent tab, 18
Recent Templates icon, 15
Recheck Document button, 51
recoloring pictures, 140
Recover Draft Versions function, 19
recovering unsaved files, 234
References tab, 189, 191, 193
relational diagrams, 149–151
Remove Background command (pictures), 

141
Remove Space After Paragraph option, 81
Remove Space Before Paragraph option, 

81
renaming new tabs (ribbon), 216–217
reorganizing documents, 183–185
Replace Text As You Type check box, 53
replacing text, 47
researching subjects, 55
Research tool, 55
Reset Picture function, 139
resizing. See sizing
Restrict Permission by People option, 233
reviewing documents

basics, 206
combining reviews, 210
comparing changes in document, 

208–209
reviewer comment (illustration), 9
reviewing shared file information, 204
Review tab, 22, 55, 202, 206
with Tracked Changes, 207

revision marks (Tracked Changes), 
206–207

ribbon
customizing, 216–219
illustration, 8
showing/minimizing, 223
Size section, 132
tools (illustration), 33

Rich Text Format (RTF), 159
Right Indent marker, 84
Rotate button, 138
Rotation handle (shapes), 136
rows and columns, adding/deleting, 

115–116
rulers

illustrations, 8, 33
Ruler check box, 85
setting indents with, 84
showing distance between cell 

boundaries with, 119
Rules tool, 169
running heads, 109

S
Sample Templates icon, 15
saving

documents, 14
documents as Web pages, 161
documents  to shared spaces, 198
recovering unsaved files, 234
Save As command, 41
Save As dialog box, 14, 231
styles, 66
text boxes as default, 88

Scale box (character spacing), 82
scaling documents for printing, 26
screenshots, 129
ScreenTip button (hyperlinks), 23
ScreenTip dialog box, 24
searching text, 38–39

sections (text)
dividing documents into, 108
moving, 185

security
File Block behaviors, 229
file validation, 229
limiting changes to files, 232–233
in Office 2010, 227
password protecting files, 231
Protected View settings, 230
Trust Center, 228

selecting
text, 34–35
text boxes, 88

Select Recipients button (form letters), 170
Set As Default Text Box option, 88
sets, style, 68
shading

adding to paragraphs, 96
for cell grouping, 124

shapes, 128–129, 135–136
shared files (co-authoring), 204–205
SharePoint Workspaces 2010, 4
Show Comments And Changes option, 42
Show Document option (master 

documents), 186
Show/Hide function (Paragraph group), 

105
Show/Hide tool, 13, 104
showing/minimizing ribbon, 223
Show One/Two Page(s) options, 42
Show Printed Page option, 42
Shrink Font tool, 79
sidebars, 87
Single File Web Page Document format, 

159
sizing

fonts, 79
pictures, 132
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Sizing handle (shapes), 136
table rows/columns, 120
tables, 119

SmartArt, 41, 129, 149–151
sorting

lists, 182
Sort Text dialog box, 182
tables, 181

space between characters, 82
space mark (illustration), 9
spacing lines within/between paragraphs, 

80–81
spelling and grammar

customizing spelling dictionaries, 225
Spelling and Grammar checker, 50–51
status icon (illustration), 9

splitting cells (tables), 121
squiggles, 51
status bar, 222
styles

applying and saving, 66
applying from styles palette, 67
applying to tables, 125
choosing from gallery, 66
of fonts, 78
for multilevel lists, 76
style sets, changing, 68
Styles gallery, themes and, 63
Styles Pane Options dialog box, 67
types of, 61
vs. direct formatting, 83

subdocuments, opening from master 
document, 186

subjects, researching, 55
Symbol dialog box, 73
Synchronous Scrolling, 211

T
table of contents, 190–191
tables

aligning, 122
for aligning text in columns, 85
anatomy of, 112
applying styles to, 125
cells, dividing, 121
creating from text, 114
customizing layout of, 119
formatting, 124
moving, 123
nesting, 122
positioning elements in, 117–118
rows and columns, adding/deleting, 

115–116
rows/columns, sizing, 120
sorting, 181
styles, 61
vs. tab stops, 85
Table Tools Design tab, 121, 124
Table Tools Layout tab, 121, 122–123
using predesigned, 113

tabs
AutoCorrect, 54
Chart Tools Design, 154
command tabs, 8
Contextual, 9
creating/renaming new, 216–217
Developer, 226
Document, 37
Drawing Tools Format, 146
Drawing Tools Format contextual, 145
File, 13, 17, 25, 26
General, 222
Header & Footer Tools Design, 109
Home, 8, 13, 38
Info, 18

Insert, 128, 131
Labels, 168
Line And Page Breaks, 106
Mailings, 171
Outlining, 183, 186
Page Layout, 64, 65, 92, 94, 104, 108
Picture Tools Format, 132, 133, 137
Recent, 18
References, 193
Review, 22, 55
Table Tools Design, 124
View, 33, 36

tabs, text
Decimal tab stop, 117
formatting with, 85–86
setting, 85
Tab key, 75
tab stops, 8

templates
creating documents with, 15–16
creating from scratch, 101
customizing, 98–99
designing from existing files, 100
for form letters, 172
Template Document format, 158

text
adjusting flow of, 106
aligning in tables, 117
automatic correction of, 52–54
converting table text to regular text, 

114
copying/moving, 35, 44–46
correcting automatically, 52–54
creating artistic, 148
creating tables from, 114
cutting/copying, 44
drag and drop function, 20
editing basics, 30–32
entering sample, 12
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files, inserting in documents, 21
formatting, 69–70
keyboard shortcuts for editing, 31–32
methods for editing, 34–35
pasting, 45–46
replacing, 47
searching, 38–39
selecting/modifying, 30
Text Direction tool, 118
Text Effects gallery, 148
Text Wrapping section, 122
translating, 56
using as hyperlinks, 23–24
wrapping, 123
wrapping around graphics, 142–143

text boxes
drawing, 87
inserting predesigned, 87–88
linking text between, 89
saving, 88
Text Box gallery, 87

themes
choosing and changing, 63–64
defined, 60
modifying, 65

thumbnails, viewing, 37
Time And Date tool, 101
tools

renaming and adding to groups, 
218–219

Tools menu, 43
Track Changes function, 206–207
translating text, 56–57
Trust Center, 228
two-sided documents, 103

U
Undo button, 30
Undo tool, 79, 181
ungroup items, 145
unlinking headers and footers, 180
unsaved files, recovering, 234
updating

shared files, 205
Table of Contents, 191
Update Services (translations), 57
Update Table tool, 191

V
validation of files, 229
variable headers and footers, 178–179
viewing

documents side by side, 211
thumbnails, 37
View options menu, 42
View tab, 33, 36, 211

views
Backstage, 15, 18
Draft, 8, 11, 188
Full Screen Reading, 8, 10, 33
Outline, 8, 11, 188
Print Layout, 8, 10, 176
setting, 33
View Gridlines function, 121
View Options menu, 42
Web Layout, 8, 10, 188

W
Web Layout view, 8, 10, 188
Web Page Document format, 159
Web pages, saving documents as, 161

widows, defined (text), 106
wildcard characters, 39
Windows Clipboard, 44
Windows Live, 4
Windows Live Sign-In Assistant, 199
Windows Live SkyDrive

opening documents in, 199
overview, 4, 197

Windows Split bar, 211
Windows Vista Plain & Simple, 5
windows, Word 2010, 8
Word 2010

customizing, 4
file formats, 158–159
launching, 12
location of tools in window, 8–9
Macro-Enabled Document format, 158
Macro-Enabled Template Document 

format, 158
new features in, 4–5
overview of this book, 2–4
Template Document format, 158
Trust Center, 228
views summary, 10–11
visual appearance of, 5
Word Document format, 158
Word Help dialog box, 27
Word Options dialog box, 24, 101, 221
Word Template Save As type, 100
XML Document format, 158

Word 2010 Web App
overview, 196
saving documents to shared spaces, 198

WordArt, 148
word count (illustration), 9
work area, customizing, 222–223
Works 6.0-9.0 Document format, 159
wrapping text, 123, 142–143
writing/publishing blogs, 164–166
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X
XML Word Document format, 158

Z
Zoom control, 8, 12, 33, 104, 179
Zoom tool, 25
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